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SAMSUNG CJX-1050W All-in-One Printer

Your SAMSUNG All-in-One Printer combines ease-of-use and affordable inks to provide  
high-quality pictures and documents.

Resources

Support is available! Go to www.samsung.com/printer for:

■■ answers to questions
■■ software upgrades
■■ and more!

If you prefer, you can chat online, send us an e-mail, or call for technical support.  
Go to www.samsung.com/printer.
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Contact SAMSUNG worldwide
If you have any comments or questions regarding Samsung products, contact the 
Samsung customer care center.

Country / Region Customer Care Center Web Site

FRANCE 01 48 63 00 00 www.samsung.com/printer

GERMANY 01805 - SAMSUNG  
(726-7864 € 0,14/min)

www.samsung.com/printer

ITALY 800-SAMSUNG (726-7864) www.samsung.com/printer
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Components

Printer Overview

This printer lets you print, copy, and scan pictures and documents.

1

1 	 Left paper-edge guide 

2 	 Paper guard 

3 	 Paper input tray

4	 Right paper-edge guide

5 	 Paper output tray

6 	 Output tray extender
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7 	 Scanner glass 

8 	 Scanner lid 

9 	 Control panel

10 	 Memory card slot

11 	 Wi-Fi connectivity LED
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12

13

210

12 	 Access door

13 	 Printhead with ink cartridges installed 

14 	 USB port

15 	 Power cord connection port
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Control panel
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Feature Description

1 LCD Displays pictures, messages, and menus; lifts for easy 
viewing

2 Cancel button Stops the current operation and returns to the menu

3 Menu button Displays the main menu

4 Navigation buttons Used to navigate menus, scroll through pictures

5 Zoom buttons Enlarge or reduce the size of the displayed picture

6 Rotate button Changes the orientation of the displayed picture

7 Start button Begins copying, scanning, printing, maintenance tasks, 
and file transfer

8 OK button Selects a menu item, accepts a zoom setting, or allows 
you to continue with the current operation

9 Back button Displays the higher level screen in the menu structure

10 Power button Turns the printer on or off
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Print Manager Software
SAMSUNG Print Manager Software is installed with your SAMSUNG All-in-One Printer 
Software unless you chose otherwise during installation. The Print Manager icon will 
appear on your desktop.

On a computer with WINDOWS Operating System (OS), you can use Print Manager  
Software to browse and edit pictures, print, copy, scan, order supplies, and configure your 
all-in-one printer from your computer.

On a computer with MAC OS, you can use Print Manager Software to order supplies and 
configure your printer from your computer.

Configuring printer settings
To set or change basic printer settings:

1	 Press Menu.
2	 Press  to select Printer Settings, then press OK.
3	 Press  to select one of the following settings:

■■ Date and Time
–– Press OK, then press  to select Year, Month, Day, Hour, or Minute.
–– Press  or  to change the values; press OK when you are done making 
changes.

–– Press Back to go back to the Printer Settings menu.
■■ Time to Low Power
To conserve energy, your printer will enter a low power (sleep) mode after being 
idle for a default delay time of 1 hour. You can increase the delay time to low 
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power (in 0.5 hour increments) up to 4 hours. Increasing the delay time may 
result in reduced energy savings.

–– Press  to change the time to energy-saving sleep mode (select from 1 to 4 
hours in 0.5 hour increments).

■■ Tagged Images Printing (see Printing tagged pictures, page 36)
–– Press  to select Off or On.

■■ Language
–– Press OK, press  to select a language, then press OK.

■■ Country/Region
–– Press OK, press  to select a country or region, then press OK.

■■ Reset All Settings (see Resetting factory defaults, page 71)
NOTE: Resetting factory defaults does not change the date and time, language, 

country/region, or network settings.

■■ Printer Info
–– Press OK to view the Firmware Version number; press OK when you are done.

4	  Press Back to return to the Main Menu.

Paper
For the best photo printing results, use KODAK Photo Papers, which are optimized to 
work with SAMSUNG All-in-One Printers.

For the best document printing results, use KODAK Document Papers or a paper with the 
COLORLOK Technology logo on the package. Use only paper that is designed for inkjet 
printers.
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Paper types
You can use:

■■ Plain paper — 16 to 24 lb / 60 to 90 gsm
■■ Photo paper — up to 12 mils
■■ Card stock — 110 lb / 200 gsm, max
■■ Envelopes — most standard types
■■ Labels — all commercially available inkjet varieties on 8.5 x 11-in. or A4 sheets
■■ Iron-on transfers — all inkjet varieties on 8.5 x 11-in. or A4 sheets

Paper sizes

Minimum size Maximum size

English units 4 x 6 in. 8.5 x 14 in.

Metric units 10 x 15 cm 22 x 36 cm
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Loading paper
1	 Lift the input tray.

2	 Pull out the output tray until it is fully extended.
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Loading plain paper

The input tray capacity is 100 sheets of plain paper.

To load plain paper:

1	 Fan and stack the paper.
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2	 Make sure the left and right paper-edge guides are in the plain-paper position, then 
insert the paper into the input tray.
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Loading photo paper

The paper tray capacity is 20 sheets of photo paper.

To load photo paper:

1	 Remove any plain paper from the tray.
2	 Insert the paper (short side first) into the input tray with the logo side facing 

toward the tray and the glossy side toward you.

IMPORTANT: If the photo paper is loaded the wrong way, the image quality will be 
affected.

3	 Move the paper-edge guides until they touch the paper.
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Networking Your Printer 

Connecting to a wireless network
To connect your printer to an 802.11b/g/n wireless (Wi-Fi) network, refer to the following 
information.

Before you connect
You need:

■■ a wireless router.
■■ to determine whether your wireless router supports Wi-Fi Protected Setup (WPS).

NOTE: If you have specific questions about your router, see your router manufacturer’s 
documentation for more information.

Connecting to a wireless network using the Wi-Fi Setup Wizard
You can use the Wi-Fi Setup Wizard on the printer to connect to your wireless network. 
Read the following procedures and use the one that is appropriate for your network 
setup.

This section explains how to configure your wireless network settings.

2
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Connecting to a non-WPS wireless router

To connect your printer to your wireless network, you need to know the network name, 
also called the Service Set Identifier (SSID). You can obtain your network name from the 
wireless router.

If your network has security enabled, you also need to know the Security String 
(passphrase or password).

Record your network information in the spaces below, using the correct uppercase and 
lowercase letters.

Network Name (SSID): _______________________________________________

Security String (case-sensitive): _________________________________________

1	 Press Menu.
2	 Press  to select Network Settings, then press OK.
3	 With Wi-Fi Setup Wizard selected, press OK.
NOTE: The Wi-Fi radio turns on when you select Wi-Fi Setup Wizard.

The Wi-Fi connectivity LED blinks as the printer searches for available wireless 
networks within range, then displays the list in order of signal strength. For example:

Network1	 100%
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If there are more networks than can be shown on the LCD, a  (page down) symbol 
appears in the bottom right of the display.

4	 Press to select your network, then press OK. 
If you don’t see your network in the list, or if you want to change your network, 
select Rescan for Wireless Networks, then press OK.

NOTE: If the name of your network is not listed, make sure your wireless router is turned 
on and within range. 

5	 If your network requires a password, use the LCD keyboard to enter your Security 
String.

On the control panel, press , ,  or  to 
select the letters and numbers, using the correct 
uppercase and lowercase letters. Press OK after 
each character.  When you are done, select 
DONE, then press OK. 

a

6	 When the confirmation message appears, press OK.

www.kodak.com/go/aiosupport 7

KODAK ESP C315 All-in-One Printer

The Wi-Fi connectivity LED blinks as the printer searches for available wireless 
networks within range, then displays the list in order of signal strength. For 
example:

If there are more networks than can be shown on the LCD, a  (page down) 
symbol appears in the bottom right of the display. 

4. Press  to select your network, then press OK. 

If you don’t see your network in the list, or if you want to change your network, 
select Rescan for Wireless Networks, then press OK.

NOTE: If the name of your network is not listed, make sure your wireless router 
is turned on and within range. If the name of your network is still not 
listed, go to www.kodak.com/go/inkjetnetworking for more information.

5. If your network requires a password, use the LCD keyboard to enter your 
Security String. 

6. When the confirmation message appears, press OK.

On the control panel, press , , or  
to select the letters and numbers, using the 
correct uppercase and lowercase letters. 
Press OK after each character. When you are 
finished, select DONE, then press OK

When the printer is successfully connected, the Wi-Fi connectivity LED will stop 
blinking and stay on steadily.
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The printer with a wireless connection is listed as the name of the printer plus a 
number (for example, Samsung CJX-1050W+0034).

Connecting to a WPS wireless router

If your router supports Wi-Fi Protected Setup (WPS), you can use WPS Connect. WPS lets 
you configure your printer for a wireless network by pressing buttons or entering a PIN.

To connect to a network using WPS:

1	 Press Menu.
2	 Press  to select Network Settings, then press OK.
3	 With Wi-Fi Setup Wizard selected, press OK.
NOTE: The Wi-Fi radio turns on automatically when you select Wi-Fi Setup Wizard.

4	 With WPS Connect selected, press OK.

WPS Connect
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5	 Select one of two methods of connecting:

IMPORTANT: Before you press OK on the printer, make sure you know where the 
router’s push button is, or where to enter the generated PIN. If necessary, 
consult your Internet service provider or router device manufacturer’s 
documentation for more information.

Pressing a button Entering a PIN

NOTE: You will have two minutes to 
press or select the WPS button. 
It may be a button on the device 
or a virtual button in the device’s 
software.

a	 With Push Button Configuration 
selected, press OK.

b	 Press or select the WPS button for 
your wireless router.

a	 Press  to select Generate WPS 
PIN, then press OK.

b	 In your wireless router’s software, 
locate the PIN screen.

c	 Enter the PIN you received on the 
LCD into the PIN screen.

6	 When the confirmation message appears, press OK.

www.kodak.com/go/aiosupport 9

KODAK ESP C315 All-in-One Printer

5. Select one of two methods of connecting: 

IMPORTANT: Before you press OK on the printer, make sure you know where the 
router's push button is, or where to enter the generated PIN. If 
necessary, consult your Internet service provider or router device 
manufacturer’s documentation for more information.

6. When the confirmation message appears, press OK.

When the printer is successfully connected, the Wi-Fi connectivity LED stops 
blinking and stays on steadily.

The printer with a wireless connection is listed as the name of the printer plus a 
number (for example, KodakESPC315+0034).

NOTE: If you are unable to connect your printer, go to 
www.kodak.com/go/inkjetnetworking for more information. 

7. If you haven’t yet installed the KODAK All-in-One Printer Software: 

a. Go to www.kodak.com/go/aiodownloads. 

b. In the results list, click the link for KODAK All-in-One Printer Software for 
either WINDOWS or MACINTOSH Operating System, depending on your 
computer’s operating system.

c. Follow the on-screen instructions to install the software. 

Pressing a button Entering a PIN

NOTE: You will have two minutes to 
press or select the WPS button. 
It may be a button on the device 
or a virtual button in the device’s 
software.

a. With Push Button Configuration 
selected, press OK. 

b. Press or select the WPS button for 
your wireless router.

a. Press  to select Generate 
WPS PIN, then press OK.

b. In your wireless router’s software, 
locate the PIN screen.

c. Enter the PIN you received on the 
LCD into the PIN screen. 

When the printer is successfully connected, the Wi-Fi connectivity LED stops blinking 
and stays on steadily.
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The printer with a wireless connection is listed as the name of the printer plus a 
number (for example, Samsung CJX-1050W+0034).

Setting up an IP address

IMPORTANT: You should only need to set up an IP address for your printer if you are 
having a problem with connecting. Typically, it is not necessary to set up an 
IP address. This procedure is for advanced users who know how to obtain 
the IP address for the printer.

All IP address entries have the following format: 000.000.000.000. Within each three-
digit grouping, the number must be right-justified. If an address or subnet mask has only 
one or two characters between the periods, include one or two leading zeros in front of 
that number. For example:

The address as it may appear in 
your documentation

How to enter the address in the 
printer menu

149.89.138.149 149.089.138.149

149.2.40.149 149.002.040.149

To set up your IP address on the printer:

1	 Press Menu.
2	 Press  to select Network Settings, then press OK.
3	 Press  to select Advanced IP Address Setup, then press OK.
4	 Press OK again to continue.
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5	 Select one of the following, then press OK:
■■ Dynamic (DHCP)
■■ Manual (Static)

6	 If you selected Manual (Static), you are prompted to enter an IP address, a Subnet 
Mask, a Gateway Address, and a DNS Server address. Press OK after each entry. Use 
the navigation buttons to enter each digit of the numbers. 
Consult your Internet service provider or network administrator for more information.

Viewing the network configuration
To view the network configuration and verify that you are connected to your wireless 
network:

1	 Press Menu.
2	 Press  to select Network Settings, then press OK.
3	 Press  to select View Network Configuration, then press OK. 

The wireless or Ethernet network settings appear on the LCD, including:
■■ Printer Hostname
■■ Connection
■■ Speed
■■ IP Address
■■ IP Address Type
■■ Network Subnet
■■ Connected Network SSID
■■ Security
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■■ Authentication
■■ Channel
■■ Region
■■ Radio (on/off)
■■ MAC Address

If the printer is connected to your network, you will see the network name and the 
word CONNECTED.

4	 To scroll through the information, press .
5	 When you are done, press OK.

Printing the network configuration
To print the current network configuration:

1	 Load plain paper into the printer. (see Loading plain paper, page 10)
2	 Press Menu.
3	 Press  to select Network Settings, then press OK.
4	 Press  to select Print Network Configuration, then press OK.
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Adding a wireless network connection to  
a USB-connected computer
You can change the way you connect to your printer at any time.

Changing from USB to a wireless connection
To change the printer connection type from USB to a wireless (Wi-Fi) network:

If your printer is connected to a computer with WINDOWS OS:

1	 Unplug the USB cable from your printer and computer.
2	 On the printer control panel, press Menu.
3	 Press  to select Network Settings, then press OK.
4	 Press  to select View Network Configuration, press OK, then confirm that the IP 

Address is not 0.0.0.0.
5	 If you have not already done so, connect your printer to your wireless network. 
6	 Select Start > All Programs > Samsung > Samsung Printer Setup Utility.

■■ If your wireless all-in-one printer (example: Samsung CJX-1050W+0034) is not 
listed:
a	 Select No, my printer is not listed, then click Next.
b	 Select your printer from the list.
c	 Select Network - Wireless/Wi-Fi, then click Next. 

When your printer is detected, driver installation begins.
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■■ If your wireless all-in-one printer (example: Samsung CJX-1050W+0034) is listed:
a	 Highlight the all-in-one printer that is connected to your network.
b	 Select Yes, my printer is listed, then click Next. 

When your printer is detected, driver installation begins.
7	 When driver installation is complete, click Done.
The printer with a wireless connection is listed as the name of the printer plus a number 
(for example, Samsung CJX-1050W+0034).

If your printer is connected to a computer with MAC OS:

1	 Unplug the USB cable from your printer and computer.
2	 On the printer control panel, press Menu.
3	 Press  to select Network Settings, then press OK.
4	 Press  to select View Network Configuration, press OK, then confirm that the 

IP Address is not 0.0.0.0.
5	 Select Apple > System Preferences.
6	 Under Hardware, select Print & Fax.
7	 In the Print & Fax dialog box, click +.
8	 Select your printer from the list, then click Add.
The printer with a wireless connection is listed as the name of the printer plus a number 
(for example, Samsung CJX-1050W+0034).
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Basic Functions

Printing

Printing documents
To print a document from your computer:

1	 Open the document.
2	 Select File > Print.
3	 In the Print window, select your SAMSUNG Printer.
4	 Choose the pages to print, number of copies, etc, then click OK (on a computer with 

WINDOWS OS) or Print (on a computer with MAC OS).

3
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Printing two-sided documents

You can print two-sided documents on any size paper that the printer accepts  
(see Paper sizes, page 8) by rotating the paper manually as described below.

IMPORTANT: Two-sided printing can only be done on media that can absorb ink on 
both sides, such as plain paper or two-sided photo paper. Two-sided 
printing will not work on bar-coded photo paper (the bar code is on the 
back side).

Printing two-sided documents from a computer with WINDOWS OS

To print two-sided documents from a computer with WINDOWS OS:

1	 Load paper into the paper input tray.
2	 Open the document you want to print, then select File > Print.
3	 In the Print dialog box, make sure that SAMSUNG CJX-1050W Series AiO is 

selected, then click Properties.
4	 Select the Layout tab.
5	 In the Two-sided printing field, select Manual (Instructions provided), then click OK.
6	 Click OK.
7	 When a message appears on your computer or printer LCD, remove the printed 

pages from the output tray, and follow the instructions on the computer or LCD.
8	 Turn the printed pages over, and place into the input tray (top edge down and 

printed side away from you).
9	 Press Start on the printer.



Basic Functions

25EN

Printing two-sided documents from a computer with MAC OS

To print two-sided documents from a computer with MAC OS:

1	 Load paper into the paper tray.
2	 Open the document you want to print, then select File > Print.
3	 In the Print dialog box, make sure that SAMSUNG CJX-1050W is selected.
4	 In the Copies & Pages drop-down list, select Paper Handling.
5	 In the Pages to Print drop-down list, select Odd Only.
6	 In the Page Order drop-down list, select Reverse.
7	 Click Print.
8	 When the odd pages have finished printing, remove them from the output tray.
9	 Turn the printed pages over, and place into the input tray (top edge down and 

printed side away from you).
10	Select File > Print.
11	 In the Copies & Pages drop-down list, select Paper Handling.
12	 In the Pages to Print drop-down list, select Even Only.
13	 In the Page Order drop-down list, select Normal.
14	Click Print.
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Printing pictures
You can print pictures with your all-in-one printer from:

■■ A memory card inserted into the memory card slot.
■■ An iPhone/iPod Touch. 

You can also print pictures using Print Manager Software from your computer with 
WINDOWS OS. Print Manager Software lets you edit and enhance your pictures quickly. 
Open Print Manager Software, select Print Pictures, then follow the on-screen instructions.

On a computer with either MAC OS or WINDOWS OS, you can print pictures from picture-
editing or photo-management software.

Printing pictures from a memory card

Your printer accepts the following memory cards:

■■ SD Card
■■ SDHC Card
■■ MMC Card
■■ MEMORY STICK
■■ Variations of the memory cards above that require an adapter (for example, 

MEMORY STICK Duo, miniSD, and microSD)

IMPORTANT: If you use a memory card with an adapter, make sure you insert and 
remove the adapter and the memory card as a unit; do not remove the 
memory card while leaving the adapter in the printer.
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To print a picture from a memory card:

1	 Insert the memory card into the memory card slot.

memory card slot

2	 Use  or  to browse to the picture you want to print.
3	 Use the Zoom, Rotate, and Navigation buttons to edit your picture, as needed.
4	 Press OK to select your picture.
5	 Repeat steps 2 through 4 for each same-size picture you want to print.
6	 Select a print size.

a	 Press Back.
b	 Press  to select Print Size.
c	 Press  to navigate to the size picture you want to print.

7	 Press Start to begin printing.
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Viewing pictures on a memory card

When you insert a memory card into the memory card slot on your printer, the pictures on 
the card appear on the LCD. Press  or  to scroll through the pictures. 

If the printer is idle for more than two minutes, the LCD will revert to the status display. 
To view the pictures again, press any button, then press  or  .

Finding pictures on a memory card

Your printer can help you locate pictures on a memory card by the date the picture was 
taken or last saved.

To locate pictures:

1	 Insert the memory card into the memory card slot.
2	 Press Menu.
3	 Press  to select View / Print Photos, then press OK.
4	 Press  to select Find Photos, then press OK.
5	 In the View by Date menu, press to select Year, Month, or Day; press  or  to select 

the specific year, month, or day. 
The number of photos found for the date you specified appears under the menu 
name. To view these pictures, press OK.

6	 To view these pictures, press OK.
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Using default settings to print a picture

To print a picture from a memory card using the factory default settings:

1	 Load photo paper (short side first) into the center of the input tray with the glossy 
side toward you (see Loading photo paper, page 12), and move the paper-edge 
guides until they touch the paper.

IMPORTANT: Always load the paper short side first. The printer automatically detects 
the orientation of the picture, whether it’s portrait or landscape, and prints 
accordingly. If the photo paper is loaded in the wrong direction, the image 
will be cut off and the paper may jam. If the paper is loaded with the 
wrong side up, the image quality will be affected.
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2	 Insert the memory card into the memory card slot.

memory card slot

3	 Press  or  to display the picture you want to print.
4	 Press Start to begin printing. 

The printer prints one 4 x 6 in. / 10 x 15 cm picture.

IMPORTANT: To prevent loss of data from your memory card, do not remove it from the 
printer while printing.



Basic Functions

31EN

Changing the settings and printing pictures

You can change the print photos options for an individual picture or group of pictures, or 
you can change the settings and save them as the default.

To print a picture or pictures using settings other than the default settings:

1	 Load photo paper with the glossy side toward you (see Loading photo paper, page 
12), and move the paper-edge guides until they touch the paper.

2	 Insert the memory card into the memory card slot. A picture appears on the LCD.

memory card slot

3	 Press  or  to select the picture you want to print, then press OK.
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4	 Repeat step 3 for each picture you want to print.
5	 Press Back for Print Photos Options.
6	 Press  to select an option (see table below), then press  or  to change the 

setting.

Print Photos Option Settings Description

View Photos -- Scroll through the pictures on the 
memory card; press OK to select 
the picture for printing; press Back 
to display the Print Photos Options 
menu.

Find Photos -- Press OK, then select a year, month, 
and/or day to view photos by date 
that they were taken; press OK to 
view the photo(s); press Back to 
display the Print Photos Options 
menu. 

Transfer All to PC -- To transfer all the pictures on the 
memory card to your computer, 
press OK then Start. (Your printer 
and computer must be connected 
with a USB cable.)

Quantity 1 (default) to 99 The number of copies that print. 
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Print Photos Option Settings Description

Color Color (default) Prints full color.

Black & White Prints black and white (grayscale).

Print Size 2 x 3

3.5 x 5

4 x 6 (default)

4 x 7

4 x 8

5 x 7

4 x 12

8 x 10

8.5 x 11 or A4

If the selected copy size is smaller 
than the paper in the paper tray, the 
printer automatically arranges the 
pictures to best fit the paper size.

Plain Paper Quality Normal (default) Good quality output; prints faster 
than Best.

Best The highest quality.

Draft The fastest print speed.
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Print Photos Option Settings Description

Photo Paper Quality Auto. (default) The printer detects photo paper in 
the paper tray and sets Best quality 
automatically.

Scene Balance On (default)

Off

Adjusts the image brightness to 
correct for underexposure and 
reduces the variation in contrast in 
different areas of the picture.

Add Date to Prints No (default)

Yes

Prints the date of the picture(s) (the 
date the picture was taken or last 
edited) in a corner of the print.

Save as Defaults No / Yes To save the settings as the new 
default, press OK. With Yes 
selected, press OK.

7	 When you have finished changing settings, press Start to begin printing.

IMPORTANT: To prevent loss of data from your memory card, camera, or portable drive, 
do not remove it from the printer while printing.
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Printing panoramic pictures

To print a panoramic picture, load 4 x 12 in. / 10 x 31 cm paper, or US letter or A4 paper 
in the main paper tray.

1	 Insert the memory card into the memory card slot.

memory card slot

2	 Press  or  to select the panoramic picture you want to print, then press OK.
3	 Press Back for Print Photos Options.
4	 Press  to select Print Size, then press  to select 4 x 12.
5	 Press Start.
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IMPORTANT: To prevent loss of data from your memory card, do not remove it from the 
printer while printing.

Printing tagged pictures

Some digital cameras let you tag (or “mark”) pictures on the memory card for printing. 
This creates a tag that is recognized by the printer. If you choose to print tagged pictures, 
they will be printed according to the default settings on your printer (unless otherwise 
specified by the tag from the camera).

NOTE: Refer to your camera user guide to determine whether your camera supports 
tagged (also “marked” or “DPOF”) functionality.

To print tagged pictures:

1	 Load photo paper with the glossy side toward you (see Loading photo paper, page 
12), and move the paper-edge guides until they touch the paper.
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2	 Insert the memory card into the memory card slot.

memory card slot

3	 When the “Print tagged images?” message appears, press Start.
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Copying
You can copy documents and pictures with your all-in-one printer. The printer produces 
high–quality color or black-and-white copies on a variety of paper types. 
(see Paper types, page 8)

Copying a document
You can copy a document using the default settings (see Resetting factory defaults, page 
71), or you can adjust the quantity, size, quality, and brightness of your copies (see 
Save as Defaults, page 41).

Using the default settings to copy a document

The default settings are either the factory default settings, or defaults that you have set 
on the printer.

To copy a document using the current default settings:

1	 Lift the scanner lid, and place the document face down in the right-front corner of 
the scanner glass.
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2	 Close the lid.
3	 Press Menu.
4	 Press Start to begin copying

Adjusting the settings and copying a document

To copy a document using settings other than the default settings:

1	 Lift the scanner lid, and place the document face down in the right-front corner of 
the scanner glass.

2	 Close the lid.
3	 Press Menu.
4	 With Copy Document selected, press OK.
5	 Press  to select an option, then press  or  to change the setting.
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Copy Document 
Option Settings Description

Quantity 1 (default) to 99 The number of copies that print.

Color Color (default) Prints full color.

Black & White Prints black and white (grayscale).

Copy Size Same Size 
(default)

The copy is the same size as the 
original.

Fit to Page The printer detects the size of the 
original on the scanner glass and 
the size of the paper in the paper 
tray, and automatically reduces or 
enlarges the original so that the 
copy fits on the paper.

20% to 500% Reduces down to 20% or enlarges 
up to 500% of the original size.
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Copy Document 
Option Settings Description

Plain Paper Quality Normal (default) Good quality output; prints faster 
than Best.

Best The highest quality, but the slowest 
print speed; eliminates the banding 
effect that sometimes occurs when 
printing Draft or Normal.

Draft The fastest print speed, but the 
lowest quality.

Photo Paper Quality Auto. (default) The printer detects photo paper in 
the paper tray and sets Best quality 
automatically.

Brightness Normal, -3 to 
+3 (Normal is 
default)

Lightens or darkens the copy. 
Normal is no change from the 
original; -3 is the darkest; +3 is the 
lightest.

Save as Defaults No / Yes To save the settings as the new 
default, press OK. With Yes 
selected, press OK.

6	 Press Start to begin copying.
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Changing the number of copies of a document

To change the number of copies:

1	 Lift the scanner lid, and place the document face down in the right-front corner of 
the scanner glass.

2	 Close the lid.
3	 Press Menu.
4	 With Copy Document selected, press  or  to select a number.
5	 Press Start to begin copying.

Enlarging or reducing a document

To enlarge or reduce the size of the copy:

1	 Lift the scanner lid, and place the document face down in the right-front corner of 
the scanner glass.

2	 Close the lid.
3	 Press Menu.
4	 With Copy Document selected, press OK.
5	 Press to select Copy Size.
6	 Press  or  to select an enlargement or reduction.
7	 Press Start to begin copying.
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Darkening or lightening a copy

To darken or lighten the copy:

1	 Lift the scanner lid, and place the document face down in the right-front corner of 
the scanner glass.

2	 Close the lid.
3	 Press Menu.
4	 With Copy Document selected, press OK.
5	 Press  to select Brightness.
6	 Press  to select a number below zero for a darker copy, or press  to select a 

number above zero for a lighter copy.
7	 Press Start to begin copying.

Copying a photograph
You can copy a photograph using the default settings, or you can adjust the quantity, 
size, quality, and brightness of your copies.

Using the default settings to copy a photograph

You can copy a document using the default settings (see Resetting factory defaults, page 
71), or you can adjust the quantity, size, quality, and brightness of your copies (see 
Save as Defaults, page 34).

To copy a photograph using the current default settings:

1	 Load photo paper into the printer (see Loading photo paper, page 12).
2	 Lift the scanner lid, and place the photograph face down in the right-front corner of 

the scanner glass.
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3	 Close the lid.
4	 Press Menu.
5	 Press  to select Copy Photo.
6	 Press Start to begin copying.

Adjusting the settings and copying a photograph

To copy a photograph using settings other than the default settings:

1	 Lift the scanner lid, and place the photograph face down in the right-front corner of 
the scanner glass.

2	 Close the lid.
3	 Press Menu.
4	 Press  to select Copy Photo, then press OK.
5	 Press  to select an option, then press  or  to change the setting.

Copy Photo Option Settings Description

Quantity 1 (default) to 99 The number of copies that print.

Color Color (default) Prints full color.

Black & White Prints black and white (grayscale).
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Copy Photo Option Settings Description

Copy Size 2 x 3

3.5 x 5

4 x 6 (default)

4 x 7

4 x 8

5 x 7

4 x 12

8 x 10

8.5 x 11 or A4

The printer enlarges or reduces the 
original to make it the copy size you 
select.

If the selected copy size is smaller 
than the paper in the paper tray, the 
printer automatically arranges the 
pictures to best fit the paper size.

Plain Paper Quality Normal (default) Good quality output; prints faster 
than Best.

Best The highest quality, but the slowest 
print speed; eliminates the banding 
effect that sometimes occurs when 
printing Draft or Normal.

Draft The fastest print speed, but the 
lowest quality.
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Copy Photo Option Settings Description

Photo Paper Qualitya Auto. (default) The printer detects photo paper in 
the paper tray and sets Best quality 
automatically.

Brightness Normal (default)

-3 to +3

Lightens or darkens the copy. 
Normal is no change from the 
original; -3 is the darkest; +3 is the 
lightest.

Preview No (default) 

Yes

To see a preview of the photograph 
on the LCD, select Yes.

Save as Defaults No / Yes To save the settings as the new 
default, press OK. With Yes 
selected, press OK.

a.	� For photo paper quality copies, load photo paper into the printer (see Loading photo paper, 
page 12)

6	 Press Start to begin copying.
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Changing the number of copies of a photograph

To change the number of copies:

1	 Lift the scanner lid, and place the photograph face down in the right-front corner of 
the scanner glass.

2	 Close the lid.
3	 Press Menu.
4	 Press  to select Copy Photo, then press OK.
5	 Make sure Quantity is selected.
6	 Press  or  to select a number.
7	 Press Start to begin copying.

Enlarging or reducing a photograph

To enlarge or reduce the size of the copy:

1	 Lift the scanner lid, and place the photograph face down in the right-front corner of 
the scanner glass.

2	 Close the lid.
3	 Press Menu.
4	 Press  to select Copy Photo, then press OK.
5	 Press  to select Copy Size.
6	 Press  or  to select the copy size.
7	 Press Start to begin copying.
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Darkening or lightening a photograph

To darken or lighten the copy:

1	 Lift the scanner lid, and place the photograph face down in the right-front corner of 
the scanner glass.

2	 Close the lid.
3	 Press Menu.
4	 Press  to select Copy Photo, then press OK.
5	 Press  to select Brightness.
6	 Press  to select a number below zero for a darker copy, or press  to select a 

number above zero for a lighter copy.
7	 Press Start to begin copying.
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Scanning
Scanning digitizes documents and pictures, and sends the digital files to your computer.

When you scan, the digital file can:

■■ Open in Print Manager Software (when connected to a computer with WINDOWS OS)
■■ Open in a third-party scanner software
■■ Be saved in a format and location that you determine (see Changing the scan 

settings for scanning from the control panel, page 49).
There are two ways to scan: From the control panel on the printer, or from a software 
program on the computer. Scanning from a software program on the computer (such as 
Print Manager Software) is recommended because it gives you more options.

Before you begin scanning
Make sure that the printer is connected to a computer using a USB cable or wireless 
network (see Chapter 2, Networking Your Printer). If you plan to scan directly from the 
printer control panel, you may change the scan settings as described below.

Changing the scan settings for scanning from the control panel

Adjust the scan settings that the printer uses before you scan from the printer control 
panel.

1	 Open the Printer Tools window.
■■ On a computer with WINDOWS OS, select Start > All Programs > Samsung > 

Samsung AiO Printer Tools.
■■ On a computer with MAC OS, open Print Manager Software, then select the 

Tools tab.
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2	 Under the Tools heading, select Printer Scan Settings.
3	 Adjust settings for scanning documents and pictures:

a	 To select a program that scanned images or documents will appear in when you 
scan from the printer control panel:
(1)	 Select the General tab.
(2)	 Under the Program List heading, click  next to the currently selected 

program.
(3)	 From the drop-down list, select the program in which you want the scanned 

files to open.
b	 To adjust settings for scanning documents, select the Document tab, then select 

an option for each setting:

Setting Options

Scan As Black and white

Color

Grayscale

File format .pdf

.rtf �(available only when connected to a computer 
with WINDOWS OS)

.tif

.jpg

.bmp �(available only when connected to a 
computer with MAC OS)
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Setting Options

Resolution (dpi) 75

150

200

300

File Save Prompt for File Name and Location

Automatically Save - specify:

■■ Base name; by default, scanned files are 
names “scan1”, “scan2”, and so on.

■■ Location (folder) where the scanned files will 
be saved

c	 To adjust settings for scanning pictures, select the Picture tab, then select an 
option for each setting:

Setting Options

Scan As Color

Black and white

File format .jpg

.bmp

.tif
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Setting Options

Resolution (dpi) 75

150

200

300

600

Quality When connected to a computer with WINDOWS 
OS:

■■ Best for E-mail
■■ Normal
■■ High
■■ Maximum

When connected to a computer with MAC OS, a 
slider bar with:

■■ Least
■■ Medium
■■ Best
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Setting Options

Automatically Detect 
Pictures (when connected 
to a computer with 
WINDOWS OS) or Auto 
Crop (when connected to 
a computer with MAC OS)

When selected, multiple pictures placed on the 
scanner glass are saved as separate files.

File Save Prompt for File Name and Location

Automatically Save - specify:

■■ Base name; by default, scanned files are 
names “scan1”, “scan2”, and so on.

■■ Location (folder) where the scanned files will 
be saved

NOTE: Before you save a scanned file, you will be able to preview it in Print Manager 
Software, crop and sharpen the image, and adjust color, if desired. On a computer 
with WINDOWS OS, see the Print Manager Software Help (? icon) for instructions.

4	 When you are finished making selections, click OK on the bottom right of the Printer 
Scan Settings window.

5	 Close the Printer Tools window.
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Scanning from the computer
To scan a document or a picture on a computer:

1	 Lift the scanner lid, and place the document or picture face down on the glass.
2	 Close the scanner lid.
3	 Open Print Manager Software.

■■ On a computer with WINDOWS OS, double-click Scan Documents and Pictures, 
then follow the on-screen instructions.

■■ On a computer with MAC OS and Print Manager Software, select the Tools tab, click 
Scan Application, then follow the on-screen instructions.

NOTE: If you are not using Print Manager Software, open a program that allows you to 
scan, then follow the instructions.

Scanning multiple pictures simultaneously

Using Print Manager Software, you can scan multiple pictures simultaneously and save 
them as separate files.

When scanning multiple pictures, leave space between the pictures so that the printer 
can detect the separate pictures. Any pictures that overlap are interpreted as a single 
picture.
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Scanning multiple pictures when connected to a computer with WINDOWS OS

To scan multiple pictures simultaneously, and save them as separate files:

1	 Lift the scanner lid, and place the pictures face down on the glass, leaving space 
between the pictures.

2	 Close the lid.
3	 Open Print Manager Software, then double-click Scan Documents and Pictures.
4	 Make sure that Picture is selected and Collage - Combine all pictures is cleared, 

then follow the on-screen instructions.
NOTE: Click the Help icon for additional instructions.

Scanning multiple pictures when connected to a computer with MAC OS

To scan multiple pictures simultaneously, and save them as separate files:

1	 Lift the scanner lid, and place the pictures face down on the glass, leaving space 
between the pictures.

2	 Close the lid.
3	 Open Print Manager Software, then select your printer.
4	 Select the Tools tab.
5	 Click Scan Application.
6	 Select Color Picture or Black and White Picture.
7	 Select Automatically detect multiple pictures, if it is not selected.
8	 Click Preview or Scan All, then follow the on-screen instructions.
NOTE: Click the Help icon for additional instructions.
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Scanning from the control panel
To scan a document or a picture from the control panel:

1	 Lift the scanner lid, and place the original document or picture face down in the 
right-front corner of the scanner glass.

2	 Close the lid.
3	 Press Menu.
4	 Press  to select Scan, then press OK. 

The Scan Options menu appears on the LCD.
5	 Press  to select an option, then press  or  to change the setting.
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Scan Option Settings Description

Scan To USB computer 
(default)

The scanned file is sent to the 
USB-connected computer.

Name of 
computer (only 
if a computer 
is connected 
by wireless 
network)

The scanned file is sent to the 
computer on the wireless or 
Ethernet network.

Memory Card The scanned file is sent to the 
memory card in the memory card 
slot

Scan What Document 
(default)

Sets the scan settings for scanning 
a document (see Changing the 
scan settings for scanning from the 
control panel, page 49).

Photo Sets the scan settings for scanning 
a photograph (see Changing the 
scan settings for scanning from the 
control panel, page 49).
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Scan Option Settings Description

Scan Dest. (Destination) File (default) Sends the scanned file in the format 
and to the destination on your 
computer that you designate (see 
Changing the scan settings for 
scanning from the control panel, 
page 49).

Application Sends the scanned file to Print 
Manager Software.

Save as Defaults No / Yes To save the settings as the new 
default, press OK. With Yes 
selected, press OK.

6	 Press Start to make a scan.  
The scanned file appears at the destination you specified.

Ordering supplies
You can order ink cartridges online.

To order supplies, make sure that your computer is connected to the Internet, then:

1	 Open Print Manager Software.
2	 Select Order Supplies.
3	 Select the item(s) you want to buy, then follow the on-screen instructions.
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Maintaining Your Printer4

Your printer requires little maintenance. However, Samsung recommends cleaning the 
scanner glass and lid regularly to remove dust and fingerprints, which affect the quality 
and accuracy of scanning.

Except while cleaning the printer, keep the printer plugged into an AC power outlet. If 
you use a power strip, don’t turn off the power strip. (The printer does not need to be 
turned on but should be plugged in.)

For optimal performance, keep the printer connected to a computer that is powered on 
and has the Samsung Print Manager Software installed, or keep the printer powered on 
and connected to the Internet through a wireless network.

Keep the printhead and ink cartridges in the printer at all times to help prevent damage 
to the printhead.

For recycling and/or disposal information, contact your local authorities. In the US, go to 
the Electronics Industry Alliance at www.eia.org.

www.eia.org
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General care and cleaning
 CAUTION:  

Always disconnect the power to the printer before cleaning it. Do not use harsh 
or abrasive cleaners on any part of the printer.

■■ To clean the printer, wipe the outside with a clean, dry cloth.
■■ Keep the surrounding area vacuumed and litter-free.
■■ Protect the printer from tobacco smoke, dust, and liquid spills.
■■ Do not place objects on the printer.
■■ Keep the input tray free of dust, dirt, and other foreign objects.
■■ Keep the printer supplies away from direct sunlight and out of high-temperature 

environments.
■■ Do not allow chemicals to come into contact with the printer.

Cleaning the scanner glass and document backing
The scanner glass can get smudged and minor debris can accumulate on the white 
document backing under the scanner lid. Periodically clean the scanner glass and 
document backing.

 CAUTION: 
Do not use harsh or abrasive cleaners on any part of the printer. 
Do not spray liquid directly on the glass. 
Do not use paper-based wipes on the document backing as they can scratch it.
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To clean the scanner glass and document backing under the scanner lid:

1	 Turn off the printer and unplug it from the power outlet.
2	 Lift the scanner lid.

3	 Wipe the glass with a soft cloth or sponge, slightly moistened with a nonabrasive 
glass cleaner.
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4	 Dry the glass with a lint-free cloth.
5	 Gently clean the document backing with a soft cloth or sponge, slightly moistened 

with mild soap and warm water.

6	 Dry the document backing with a chamois or lint-free cloth.
NOTE: If the document backing needs further cleaning, use isopropyl (rubbing) alcohol on 

a soft cloth, then wipe thoroughly with a cloth moistened with water to remove 
any residual alcohol.

7	 When you finish cleaning, plug in the printer and press the on/off button to power 
on the printer.
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Replacing ink cartridges
Your printer uses both black and color ink cartridges. You can check the approximate ink 
levels on the LCD (see Checking ink levels, page 71). When an ink cartridge is out of 
ink, the printer LCD displays a message stating that the black or color ink cartridge needs 
replacing. You can order ink cartridges online. Open Print Manager Software and select 
Order Supplies.

IMPORTANT: Do not use refilled ink cartridges.

To replace an ink cartridge:

1	 Make sure your printer is on.
2	 Lift the printer access door, and wait for the carriage to move to a position where 

you can access it.
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3	 The ink cartridges are located in the printhead.

210

Printhead

Color ink cartridge

Black 
ink cartridge

4	 Pinch the tab on the ink cartridge.

210
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5	 Lift the ink cartridge out of the printhead.

6	 Remove the new ink cartridge from its bag.

IMPORTANT: To prevent the printhead from drying out, insert the ink cartridge into the 
printhead immediately.
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7	 Remove the protective cap from the cartridge.

8	 Insert the ink cartridge into the printhead.

210
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9	 Press down on the ink cartridge tab until you hear a click.

210

10	Close the printer access door.
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Updating the software and printer firmware
Using the latest software and firmware helps ensure optimal performance of your printer.

NOTE: Firmware is the software that runs on your printer.

Although there is a background check for software and firmware updates, you may 
update manually using the following procedure.

Updating if your printer is connected to a computer with WINDOWS OS
To update the software:

1	 Make sure that your computer is connected to the Internet.
2	 Select Start > All Programs > Samsung > Samsung AiO Printer Tools.
3	 Under Printer Resources, click Check for Software Updates to check whether 

software updates are available.
4	 If there are updates, click Next and follow the on-screen instructions.
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To update the printer firmware:

1	 Make sure that your computer is connected to the Internet.
2	 Connect the printer to the computer with a USB cable or wirelessly (if not currently 

connected).
3	 Select Start > All Programs > Samsung > Samsung AiO Printer Tools.
4	 Make sure that Samsung CJX-1050W Series AiO - Connected appears in the 

lower left corner of the Printer Tools window.
NOTE: If Samsung CJX-1050W Series AiO - Connected does not appear in the lower 

left corner, click Select, then click Refresh List and choose your printer from the 
list; click Install Samsung Printer and follow the on-screen instructions.

5	 Under Printer Resources, click Check for Printer (Firmware) Updates.
6	 If there are updates, click Next and follow the on-screen instructions.

IMPORTANT: Do not turn off or unplug your printer or your computer during the 
update. Doing so may cause the printer to become inoperable. If the 
printer is connected wirelessly, make sure you have a stable connection 
when you perform the update.
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Updating if your printer is connected to a computer with MAC OS
To update the software:

1	 Make sure that your computer is connected to the Internet.
2	 Open Print Manager Software.
3	 Select the Tools tab.
4	 Click Check for Softwate Updates.
5	 If there are software updates, follow the on-screen instructions for updating your 

software.
To update the firmware:

1	 Make sure that your computer is connected to the Internet.
2	 Connect the printer to the computer with a USB cable or wirelessly (if not currently 

connected).
3	 Open Print Manager Software.
4	 Select the Tools tab.
5	 Click Check for Printer (Firmware) Updates.
6	 If there are updates, follow the on-screen instructions.

IMPORTANT: Do not turn off or unplug your printer or your computer during the 
update. Doing so may cause the printer to become inoperable.
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Monitoring and adjusting printer performance
From the control panel, you can perform tasks to help keep the printer functioning well.

Checking ink levels
To check the ink levels:

1	 Press Menu.
2	 Press  to select Maintenance, then press OK.
3	 With Check Ink Levels selected, press OK. 

The LCD shows approximate levels of ink in the cartridges so you know when it’s 
time to order replacement cartridges.

NOTE: You can order ink cartridges online. Open Print Manager Software and select 
Order Supplies.

Resetting factory defaults
To reset defaults to the factory default settings:

1	 Press Menu.
2	 Press  to select Printer Settings, then press OK.
3	 Press  to select Reset All Settings, then press OK.
4	 When you see the message, “This will reset printer settings to factory defaults,” 

press OK.
NOTE: Resetting factory defaults does not change the date and time, language, country/

region, or network settings.
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Replacing the printhead
IMPORTANT: Replacing the printhead is not a regular maintenance procedure. Replace 

the printhead only if you receive a new printhead from Samsung.

To replace the printhead:

1	 Make sure your printer is on.
2	 Lift the printer access door, and wait for the carriage to move to the access position.
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3	 Remove both ink cartridges and set them aside.

210

210

4	 Unlatch the used printhead by lifting the button in the center of the carriage.



Maintaining Your Printer

74 EN

5	 Lift the used printhead out of the carriage.

6	 Remove the new printhead from its bag.

 CAUTION:  
Do not touch the copper contacts on the pringhead, as doing so may damage the 
pringhead.
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7	 Remove the plastic protective cap.

Copper contacts

IMPORTANT: Be careful not to scratch or touch the copper contacts while inserting the 
printhead.

8	 Place the new printhead into the carriage.



Maintaining Your Printer

76 EN

9	 Push firmly against the target label of the printhead until you hear a loud snap.

10	 Insert the black ink cartridge into the printhead.

210
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11	Press down on the ink cartridge until you hear it click into position.

210

12	Repeat steps 10 - 11 for the color ink cartridge.

210

210

13	Close the printer access door. 
The printer detects the new printhead. Follow the instructions on the LCD to calibrate 
your printer.
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Troubleshooting

Basic troubleshooting
Some problems can be resolved quickly by power cycling the printer: Turn off your printer. 
Wait five seconds. Turn on the printer.

Use the following information to help troubleshoot problems with your printer.

Problem Possible Solutions

Printer does not 
power on

■■ Make sure you are using the power cord that came with your 
printer.

■■ Make sure the power cord is connected to the AC adapter, it 
is plugged into an outlet or power strip, and that the LED on 
the AC adapter is lit.

5
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Problem Possible Solutions

Printer not 
detected

■■ Check that the printer is plugged in and turned on.
■■ If you are using a USB cable, check that:

–– it is a USB 2.0 high-speed cable.
–– it is connected to the printer and computer.
–– you restart the computer if the USB cable was discon-

nected from the printer then reconnected, or if power to 
the printer was interrupted.

■■ If you are using a wireless connection, check that:
–– the printer is connected to your wireless network. 

To check:
a	 On the printer, press Menu.

b	 Press  to select Network Settings, then press 
OK.

c	 Press  to select View Network Configuration, 
then press OK. 
Check that the Active Connection Type is WiFi, and 
that the IP Address is not zeros.

–– your router is transmitting data.
–– the firewall (excluding WINDOWS Firewall) is allowing 

the services needed for your printer.
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Problem Possible Solutions

Wireless  
connectivity

For wireless connectivity issues, go to  
Wireless Networking Setup Guide

Carriage jam ■■ Open the printer access door and clear any obstructions.
■■ Check that the printhead and ink cartridges are installed 
correctly. 
(The printhead and ink cartridges are installed correctly when 
you hear them click into place.)

Print quality ■■ For best results, use KODAK Paper or a paper with the 
COLORLOK Technology logo on the package.

■■ Make sure the paper is loaded correctly. See Loading plain 
paper, page 9 and Loading photo paper, page 11.

■■ Clean the printhead:
–– Press Menu.
–– Press  to select Maintenance, then press OK.
–– Press  to select Clean Printhead, then press OK.

■■ Calibrate the printer:
–– Press Menu.
–– Press  to select Maintenance, then press OK.
–– Press  to select Calibrate Printer, then press OK.
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Problem Possible Solutions

Ink cartridge 
errors

■■ Check that Ink Cartridge(s) are installed. Do not use refilled 
ink cartridges.

■■ Remove, then install the cartridges again. Make sure the 
cartridges click into place.

Paper jam ■■ Open the printer access door and gently remove any paper 
from inside the printer.

■■ Make sure the paper in the tray is free of tears or creases.
■■ Make sure you do not overload the input paper tray.
■■ If you cannot access the paper from the front, gently pull the 
jammed paper up from the paper input tray.

Error codes/
messages

Go to  
http://www.samsung.com/uk/support/download/
supportDownloadMain.do

http://www.samsung.com/uk/support/download/supportDownloadMain.do
http://www.samsung.com/uk/support/download/supportDownloadMain.do
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Status lights
The status lights indicate the condition of the printer. There are two status lights on the 
printer: one on the on/off button that indicates power, the other indicates Wi-Fi status.

Power light 

Power light What it means

Off ■■ The printer is turned off.
–– Press the on/off button to turn on power.

■■ The printer does not have power.
–– Make sure that the power cord is plugged into the back 

of the printer and into an electrical outlet, and that the 
electrical outlet has power.

Blinking ■■ The printer is busy.
–– Wait for the printer to finish the task.

On ■■ The printer is ready.
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Wi-Fi connectivity LED 

Wi-Fi connec-
tivity LED What it means

Off The Wi-Fi radio is either turned off or is turned on but not 
connected to a wireless network.

Blinks continu-
ously

The Wi-Fi radio is turned on, and the printer is searching for 
available wireless networks within range.

Blinks intermit-
tently

The Wi-Fi radio is turned on and the printer cannot find any 
available wireless networks within range, or the Wi-Fi radio 
connection has been interrupted, or is too weak to send signals 
to and from the printer.

To find and connect to an available wireless network within 
range, press OK, turn the Wi-Fi radio off, and run the Wi-Fi Setup 
Wizard (see Connecting to a wireless network, page 13).

On The Wi-Fi radio is turned on, and there is a working connection 
between the printer and a wireless network.
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Product and Safety Specifications

The following specifications are subject to change without notice.

Specifications and features

Print performance

ISO/IEC 24374 ESAT 7 ipm

ISO/IEC 24374 ESAT 4.6 ipm

Print technology Continuous-tone, thermal inkjet

Print quality modes Draft, Normal, and Best on plain paper Photo quality 
mode on photo paper

Photo printing features

Quantity 1 to 99

Print sizes 2 x 3 in. / 5 x 8 cm

3.5 x 5 in. / 9 x 13 cm

4 x 6 in. / 10 x 15 cm

4 x 7 in. / 10 x 18 cm

4 x 8 in. / 10 x 20 cm

4 x 12 in. / 10 x 30 cm (Panoramic)

6
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Print sizes 5 x 7 in. / 13 x 18 cm

8 x 10 in. / 20 x 25 cm

US Letter - 8.5 x 11 in. / 22 x 28 cm

A4 - 8.3 x 11.7 in. / 21 x 30 cm

Quality Best, Normal, Draft modes on plain paper 
Photo quality mode on photo paper

Auto-detect media Auto-detect plain paper and photo papers Optimize 
image quality for KODAK Photo Papers with barcode

Image enhancement Image Enhancement Technology with Print Manager 
Software

Add date to prints No (default), Yes

Color Black-and-white or color

Scene balance On (default), Off

Copy document features

Color Black-and-white or color

Quantity 1 to 99 copies

Copy sizes Same Size, Fit-to-Page, 20% to 500%

Plain paper quality Best, Normal, Draft

Brightness – 3 to + 3
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Copy photo features

Color Black-and-white or color

Quantity 1 to 99 copies

Copy sizes 2 x 3 in. / 5 x 8 cm

3.5 x 5 in. / 9 x 13 cm

4 x 6 in. / 10 x 15 cm

4 x 7 in. / 10 x 18 cm

4 x 8 in. / 10 x 20 cm

4 x 12 in. / 10 x 30 cm (Panoramic)

5 x 7 in. / 13 x 18 cm

8 x 10 in. / 20 x 25 cm

US Letter - 8.5 x 11 in. / 22 x 28 cm

A4 - 8.3 x 11.7 in. / 21 x 30 cm

Quality Automatic

Brightness – 3 to + 3

Scanning features

Scanner type Contact Image Sensor (CIS)

Maximum scan size 8.5 x 11.7 in. / 22 x 30 cm
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Functions Segmentation scanning

Auto-destination

OCR

Auto picture detection

Paper input tray features

Paper capacity 100 sheets of 20 lb plain paper

20 sheets of photo paper, up to 12 mil (290 gsm)

20 envelopes

Tray size 4 x 6 in. to 8.5 x 14 in. / 10 x 15 cm to 22 x 36 cm

Ink cartridges

Ink life The number of pages may be affected by operating 
environment, printing interval, media type, and media size.

Based on ISO 24712 5% COVERAGE PATTERN  
- See A sample of 5% COVERAGE PATTERN (reduced to 
33%), page 89.

(supplied with the machine; INK-M210): About 250 sheets 
(supplied with the machine; INK-M215): About 430 sheets  
(supplied with the machine; INK-C210): About 250 sheets 
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A sample of 5% COVERAGE PATTERN (reduced to 33%)

{|}
Funtres Solber Netener

Stephen J. Singel
Fabanda Sinpat Abarress
Tendar, BSF
URANGLE

30 November 2005

Johnathan Q. Maderia

Inpert Mampem Abaress
2343 Stantin Dawer Lank
Benhibe, SDF

Mr. Maderia:

Nam liber tempor cum soluta nobis eleifend ption cogue nihil consequat, velillum.  Dolore eu zril feugiat 
nulla acilisis at vero eros accumsan et iust odio dignis sim qui blandit praesent lutatum ril lobortis nisl ut 
aliquip exea commodo consequat. Duis autem vel eum irure dolor in hendreritin ulputate velit esse 
molestie tincidunt ut laoreet dolore magna aliquam erat volutpat. Ut wisi enim ad minim vhniam, quis 
nostrud exerci tation ullam corpersus cipit tis nisl

Amet, Amet, consectetuer adipiscing elit, sud diam nonummy nibh veniam, 
ecneps adipiscing elit, sed diam nonummy nibtil laoreet dolore magmana aliam 
erat volutpat. Ut wisi enim minim veniam, quisient nostrud. Solyom uta nobis 
eleifendoptn cogue nihil imerdiet domg id quod mzim plerat facer posim aum. 
Lorem ipsm dolor sit amet, consectuer. Duis autem vel eum iriure dolor in 
hendreritin vulputate velit cesse ea commodo molestie.  Nam liber tempor cum 
soluta nobis eleifend option cogue nihil consequat, velillum. Dolore eu zril 
feugiat nulla facilisis at vero eros accumsan et iusto odio dignissim qui blandit 
praesent domg id quod mzim plerat facer posim aum.

Integer sagittis lacus vel nulla. Morbi convallis hendrerit risus. Nullam interdum, enim non gravida 
feugiat, quam ante consequat metus, sed molestie dolor tortor eu ipsum. Phasellus semper risus sit amet 
diam. Cras wisi arcu, pulvinar nec, molestie fringilla, vestibulum iaculis, mi. Praesent nonummy pulvinar odio.

Duis vitae eros. Fusce suscipit. Etiam justo massa, semper feugiat, porttitor sit amet, nonummy in, quam. 
Aenean nulla magna, elementum ut, eleifend ac, aliquam ut, risus. Morbi laoreet elementum dui. 
Vestibulum nibh sapien, rhoncus non, lobortis nec, ullamcorper a, enim. Praesent ultricies enim non 
lorem. Curabitur consectetuer, diam et nonummy convallis, quam quam tristique nulla, pulvinar blandit 
ipsum arcu a tellus. Phasellus dolor. Ut ullamcorper venenatis quam. Quisque egestas erat.

Singabet,

Stephen J. Singel
Demperta Aminerimum
Fabanda Sinpat Abarress

SJS:dwg

A B C D E

Stnecerp Balrecneps
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Connectivity

Protocols supported USB 2.0 High Speed; DPOF

Devices supported WINDOWS OS-based and MACINTOSH Computers, 
memory cards (SD, MS/Duo, MMC, SDHC)

Image Formats supported Image printing supports JPEG (EXIF v2.2); does not 
support progressive JPEG format

Number of USB ports One rear device port (high speed)

Protocols supported USB 2.0 High Speed (for connection to computer 
only), DPOF (Tagged image printing)

Wi-Fi Technology 
supported

802.11b/g/n, WPA/WPA2, WPS, and WEP

Software support

Application support Third-party image management applications; optical 
character reader (OCR) support for documents

Media support Plain paper, photo paper, envelopes, greeting cards, 
and labels

Scanner support TWAIN and WIA, WIA2 (VISTA OS and WINDOWS 7), 
ICA (MAC OS), including segmentation scanning

Update support Software and firmware updates available through Web 
support
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Physical specifications

Power Input: 100–240 V AC, 50–60 Hz

The printer shall only be used with the provided 
certified external power supply.  

Manufacturer and model: 
Chicony Power Technology Co., Ltd, model 
A10-018N3A

Output: 36 V DC at 0.5 A

Dimensions 16.5. x 6.7. x 12.6 in. / 420 x 170 x 320 mm [L × H x D]

Weight 12.7 lb / 5.7 kg

Operating range 5°C (41°F) to 35°C (95°F), 15 to 85% RH

Full image quality environ-
mental range

15°C (59°F) to 30°C (86°F), and 20 to 80% RH.

Energy efficiency ENERGY STAR® Qualified All-in-One Printer
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System requirements

Computer with WINDOWS OS

Computer Minimum

Operating system WINDOWS 7, VISTA, or XP (SP2 or later)

CPU INTEL CELERON Processor

Clock speed 1.2 GHz

Memory 512 MB RAM

Available hard disk space 500 MB available

Interface USB 2.0 High Speed

Removable drive CD-ROM

Computer with MAC OS

Computer Minimum

Operating system MAC OS X 10.5 or later

CPU PowerPC G4, G5, or INTEL-based MAC

Clock speed 1.2 GHz

Memory 512 MB RAM

Available hard disk space 200 MB available
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Computer Minimum

Interface USB 2.0 High Speed

Removable drive CD-ROM

Paper types supported

Plain paper 16 to 24 lb (60 to 90 gsm)

Photo paper Up to 12 mil (290 gsm)

Card stock 110 lb index max (200 gsm)

Envelopes 20 to 24 lb (75 to 90 gsm)

Labels All commercially available inkjet varieties on 8.5 x 11 
in. and A4 size sheets

Iron-on transfers All commercially available inkjet varieties on 8.5 x 11 
in. and A4 size sheets
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Paper sizes supported

Plain paper A4 (8.3 x 11.7 in. / 21 x 30 cm)

A5 (5.8 x 8.3 in. / 15 x 21 cm.)

A6 (4.1 x 5.8 in. / 11 x 15 cm)

B5 (6.9 x 9.8 in. / 18 x 25 cm)

US Executive (7.3 x 10.5 in. / 18 x 27 cm)

US Letter (8.5 x 11 in. / 22 x 28 cm)

US Legal (8.5 x 14 in. / 22 x 36 cm)

Custom sizes from 4 to 8.5 in. / 10 to 22 cm wide and

6 to 14 in. / 15 to 36 cm long

Labels A4 (8.3 x 11.7 in. / 21 x 30 cm)

US Letter (8.5 x 11 in. / 22 x 28 cm)

Index card stock 4 x 6 in. / 10 x 15 cm cards

5 x 7 in. / 13 x 18 cm index cards

Iron-on transfers A4 (8.3 x 11.7 in. / 21 x 30 cm)

US Letter (8.5 x 11 in. / 22 x 28 cm)
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Envelopes C5 (6.7 x 9 in. / 16 x 23 cm)

C6 (4.5 x 6.4 in. / 11 x 16 cm)

DL (designated long) (11 x 22 cm / 4.3 x 8.7 in.)

US #7¾ (3.9 x 7.5 in. / 10 x 19 cm)

US #9 (3.9 x 8.9 in. / 10 x 23 cm)

US #10 (4.1 x 9.5 in / 10.5 x 24 cm)

Photos 4 x 6 in. / 10 x 15 cm

4 x 7 in. / 10 x 18 cm

4 x 8 in. / 10 x 20 cm

4 x 12 in. / 10 x 31 cm

5 x 7 in. / 13 x 18 cm

8 x 10 in. / 20 x 25 cm

US Letter (8.5 x 11 in. / 22 x 28 cm)

A4 (8.3 x 11.7 in. / 21 x 30 cm)
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Safety Information

Safety Information
SAMSUNG CJX-1050W All-in-One Printers are Class 1 LED Products.

When using this machine, these basic safety precautions should always be followed to 
reduce risk of fire, electric shock, and injury to persons:

1	 Read and understand all instructions.
2	 Use common sense whenever operating electrical appliances.
3	 Follow all warnings and instructions marked on the product and in the literature 

accompanying the product.
4	 Use only the power source provided with the printer.
5	 Use only the power cord that comes with the product (or an approved power cord 

greater or equal to H05W-F, 2G, 0.75mm2). Using another power cord may cause fire 
and/or shock. Do not use the included power cord with any other equipment.

6	 If an operating instruction appears to conflict with safety information, heed the 
safety information. You may have misunderstood the operating instruction. If you 
cannot resolve the conflict, contact your sales or service representative for assistance.

7	 Unplug the machine from the AC wall socket and telephone jack before cleaning. Do 
not use liquid or aerosol cleaners. Use only a damp cloth for cleaning.

8	 Do not place the machine on an unstable cart, stand, or table. It may fall, causing 
serious damage.

7
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9	 Your machine should never be placed on, near, or over a radiator, heater, air condi-
tioner, or ventilation duct.

10	Do not allow anything to rest on the power or telephone cords. Do not locate your 
machine where the cables may be damaged by people walking on them. Do not 
place the machine where the power or telephone cord may be bent. Any case of 
above may cause the hazardous result or malfunction.

11	Do not overload wall outlets and extension cords. This can diminish performance, and 
may result in the risk of fire or electric shock.

12	Do not allow pets to chew on the AC power, telephone, or PC interface cords.
13	Never push objects of any kind into the machine through case or cabinet openings. 

They may touch dangerous voltage points, creating a risk of fire or shock. Never spill 
liquid of any kind onto or into the machine.

14	To reduce the risk of electric shock, do not disassemble the machine. Take it to a 
qualified service technician when repair work is required. Opening or removing 
covers may expose you to dangerous voltages or other risks. Incorrect reassembly 
could cause electric shock when the unit is subsequently used.

15	Unplug the machine from the telephone jack, PC, and AC wall outlet, and refer 
servicing to qualified service personnel under the following conditions:
•	 When any part of the power cord, plug, or connecting cable is damaged or frayed.
•	 If liquid has been spilled into the product.
•	 If the product has been exposed to rain or water.
•	 If the product does not operate properly after instructions have been followed.
•	 If the product has been dropped, or the cabinet appears damaged.
•	 If the product exhibits a sudden and distinct change in performance
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16	Adjust only those controls covered by the operating instructions. Improper 
adjustment of other controls may result in damage, and may require extensive work 
by a qualified service technician to restore the product to normal operation.

17	Avoid using this fax machine during a lightning storm. There may be a remote risk of 
electric shock from lightning. If possible, unplug the AC power and telephone for the 
duration of the lightning storm.

18	Do not install the machine on a wet place. This may raise a risk of fire or shock.
19	CAUTION: For electrical safety reasons disconnect from telecommunications network 

before touching metal/conductive parts.
20	CAUTION: To reduce the risk of fire, use only No.26 AWG or larger telecommuni-

cation line cord.
21	CAUTION: Use only the cords and other accessories supplied with the product. Using 

others may cause the hazardous result or malfunction.
22	SAVE THESE INSTRUCTIONS.
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LCD Screen Safety
■■ Use only a dry, soft cloth to clean the LCD screen. Do not use any liquid or chemical 

cleaners.
■■ If the LCD screen is damaged, contact SAMSUNG immediately. If any of the solution 

from the display gets on your hands, wash them thoroughly with soap and water. If 
the liquid crystal solution gets into your eyes, flush your eyes immediately with water. 
If any discomfort or change in vision persists after washing, seek medical attention 
immediately.

Ink Cartridge Safety
■■ Keep all ink cartridges out of the reach of children.
■■ If ink gets on your skin, wash with soap and water. If ink gets into your eyes, flush 

your eyes immediately with water. If any discomfort or change in vision persists after 
washing, seek medical attention immediately.



Safety Information

101EN

Declaration of Conformity (European countries)
Approvals and Certifications

The CE marking applied to this product symbolises Samsung Electronics Co., Ltd.  
Declaration of Conformity with the following applicable 93/68/EEC Directives of the 
European Union as of the dates indicated:

January 1, 1995: �Council Directive 73/23/EEC Approximation of the Member States 
related to low voltage equipment.

January 1, 1996: �Council Directive 89/336/EEC (92/31/EEC), approximation of the 
Member States related to electromagnetic compatibility.

March 9, 1999: �Council Directive 1999/5/EC on radio equipment and telecommunica-
tions terminal equipment and the mutual recognition of their conformity. 
A full declatation, defining the relevant Directives and referenced 
standards can be obtained from your Samsung Electronics Co., Ltd. 
representative.
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German compliance statement

 CAUTION:  
This device is not intended for use in the direct field of view at visual display 
workplaces. To avoid incommoding reflections at visual display workplaces this 
device must not be placed in the direct field of view.

 CAUTION:  
Das Gerät ist nicht für die Benutzung im unmittelbaren Gesichtsfeld am Bildschir-
marbeitsplatz vorgesehen. Um störende Reflexionen am Bildschirmarbeitsplatz zu 
vermeiden, darf dieses Produkt nicht im unmittelbaren Gesichtsfeld platziert verden.

Noise emissions for this equipment do not exceed 70 dBa.

This equipment is not intended for use in the workplace in accordance with BildscharbV 
regulations.

“�Das GerŠt ist nicht fŸr die Benutzung am Bildschirmarbeitsplatz gemŠß BildscharbV 
vorgesehen.”
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Correct Disposal of This Product  
(Waste Electrical & Electronic Equipment)
(Applicable in the European Union and other European countries with separate collection 
systems)

                             This marking shown on the product or its literature, indicates that it 
should not be disposed with other household wastes at the end of its 
working life. To prevent possible harm to the environment or human 
health from uncontrolled waste disposal, please separate this from 
other types of wastes and recycle it responsibly to promote the 
sustainable reuse of material resources.

Household users should contact either the retailer where they 
purchased this product, or their local government office, for details of where and how 
they can take this item for environmentally safe recycling.

Business users should contact their supplier and check the terms and conditions of the 
purchase contract. This product should not be mixed with other commercial wastes for 
disposal.
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ENERGY STAR® Qualified
To conserve energy, this printer will enter a reduced power (sleep) mode automati-
cally after 1 hour. You can adjust the delay time (in 0.5 hour increments) up to 4 hours. 
Increasing the delay time may result in reduced energy savings.

                              ENERGY STAR and the ENERGY STAR mark are registered U.S. service 
marks. As an ENERGY STAR partner, SAMSUNG has determined that this 
product meets ENERGY STAR Guidelines for energy efficiency. For more 
information on the ENERGY STAR program, see www.energystar.gov.

www.energystar.gov
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